DATA COLLECTION GUIDE

2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening
(01/01/2016 to 12/31/2016 Dates of Service)

Data Submission: 04/03/2017 to 05/12/2017
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>i</td>
</tr>
<tr>
<td>Summary of Changes</td>
<td>ii</td>
</tr>
<tr>
<td>A. Measure Specification Changes from Previous Year</td>
<td>ii</td>
</tr>
<tr>
<td>B. Field Specification Changes from Previous Year</td>
<td>ii</td>
</tr>
<tr>
<td>C. Other Changes from Previous Year</td>
<td>ii</td>
</tr>
<tr>
<td>D. Changes from Draft to Final</td>
<td>ii</td>
</tr>
<tr>
<td>Measure Specifications</td>
<td>iii</td>
</tr>
<tr>
<td>Measure Logic / Flow Chart</td>
<td>v</td>
</tr>
<tr>
<td>Process and Timeline Overview</td>
<td>vi</td>
</tr>
<tr>
<td>Data Submission Resources</td>
<td>vii</td>
</tr>
<tr>
<td>Section I: Agreements and Pre-Submission Data Certification</td>
<td>1</td>
</tr>
<tr>
<td>A. Business Associate Agreement</td>
<td>1</td>
</tr>
<tr>
<td>B. Direct Data Submission Terms and Conditions</td>
<td>1</td>
</tr>
<tr>
<td>C. Data File Transfer Selection</td>
<td>2</td>
</tr>
<tr>
<td>D. Pre-Submission Data Certification</td>
<td>3</td>
</tr>
<tr>
<td>Section II: Data Collection</td>
<td>4</td>
</tr>
<tr>
<td>A. Eligible Population Identification</td>
<td>4</td>
</tr>
<tr>
<td>Total Population (recommended)</td>
<td>4</td>
</tr>
<tr>
<td>Sample Population</td>
<td>5</td>
</tr>
<tr>
<td>Patient Attribution</td>
<td>5</td>
</tr>
<tr>
<td>B. Data Collection</td>
<td>5</td>
</tr>
<tr>
<td>Data Elements and Field Specifications</td>
<td>6</td>
</tr>
<tr>
<td>C. Data Quality Checks</td>
<td>13</td>
</tr>
<tr>
<td>Section III: Data Submission</td>
<td>14</td>
</tr>
<tr>
<td>A. Data File Creation</td>
<td>14</td>
</tr>
<tr>
<td>B. Data Submission</td>
<td>15</td>
</tr>
<tr>
<td>Section IV: Data Validation</td>
<td>20</td>
</tr>
<tr>
<td>Appendices</td>
<td>22</td>
</tr>
<tr>
<td>Appendix A: About Direct Data Submission</td>
<td>22</td>
</tr>
<tr>
<td>Appendix B: About MN Community Measurement</td>
<td>24</td>
</tr>
<tr>
<td>Appendix C: Sampling Methods</td>
<td>25</td>
</tr>
<tr>
<td>Appendix D: Mental Health/Depression Instruments and Descriptions</td>
<td>27</td>
</tr>
<tr>
<td>Table 1: Depression only screeners – Highly Recommended and Public Domain</td>
<td>27</td>
</tr>
<tr>
<td>Table 2: Depression only screeners – Highly Recommended and Proprietary</td>
<td>28</td>
</tr>
<tr>
<td>Table 3: Depression only screeners – Acceptable but Not Highly Recommended and Public Domain</td>
<td>29</td>
</tr>
<tr>
<td>Table 4: General mental health screeners – Highly Recommended or Proprietary with Permission in MN</td>
<td>30</td>
</tr>
<tr>
<td>Appendix E: Glossary of Terms</td>
<td>33</td>
</tr>
</tbody>
</table>
Dear Data Submitters,

Attached is our 2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening Data Collection Guide. We greatly appreciate your medical group or clinic contributing data on quality, patient outcomes and patient experience. We know your contribution is vital to MN Community Measurement’s ability to achieve our mission to accelerate the improvement of health by publicly reporting health care information.

We value your involvement and want to support your success as well. We provide resources, tools and reports that your medical group or clinic can use for quality improvement.

The following resources can be found on our corporate website, [MNCM.org](https://www.mncm.org):

- Public reports including the Health Care Quality Report, Health Equity of Care Report, Health Care Disparities Report and Total Cost of Care Report
- Patient education and engagement resources
- Provider tools and resources
- Monthly Q & A session details
- Educational webinars throughout the year
- Health Trackers

Additionally, these resources can be found on the secure [MNCM Data Portal](https://data.mncm.org/login):

- Detailed reports and charts of clinical measure results
- Charts of specific clinical measure results segmented by race, Hispanic ethnicity, preferred language and country of origin (REL) for medical groups following best practices
- Patient Experience of Care Survey results at the domain and question-level

Finally, on [MNHealthScores.org](https://www.mnhealthscores.org), you can see public-facing results of all of our measures for clinics, medical groups or hospitals. As this is our consumer-focused site, it has less detail than is available in our reports and on the Data Portal.

MNCM is committed to working with our multi-stakeholder committees to champion the highest value measures that will make the most impact in our community, while balancing burden on organizations that supply the data. As performance improves, we have processes in place to ensure the appropriate retirement of measures to minimize burden.

Thank you again for your important role in our work. If you have questions, feel free to contact us at 612-746-4522 or support@mncm.org.

Anne Snowden, MPH, CPHQ
Director, Performance Measurement, Validation & Reporting

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: [https://data.mncm.org/login](https://data.mncm.org/login)

© MN Community Measurement, 2016. All rights reserved.
Summary of Changes

A. Measure Specification Changes from Previous Year
   1. The value set for the exclusion of patients with a diagnosis of depression or dysthymia has changed. Depression Including NOS Value Set has been replaced with Major Depression or Dysthymia Value Set.

See Measure Specifications for further detail.

B. Field Specification Changes from Previous Year
   1. Removal of punctuation from Field Names (Columns E, L, N and R).

See Data Elements and Field Specifications table for further detail.

C. Other Changes from Previous Year
   NONE

D. Changes from Draft to Final
   NONE
### Measure Specifications

<table>
<thead>
<tr>
<th>Summary of Changes</th>
<th>The value set for the exclusion of patients with a diagnosis of depression or dysthymia has changed. Depression Including NOS Value Set has been replaced with Major Depression or Dysthymia Value Set.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The percentage of patients 12-17 years of age who were screened for mental health and/or depression</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measurement Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1 through December 31, 2016</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Eligible Population</th>
<th>Eligible Specialties</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Family Medicine, Internal Medicine, Pediatric/Adolescent Medicine</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Eligible Providers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Doctor (MD), Doctor of Osteopathy (DO), Physician Assistant (PA), Advanced Practice Registered Nurses (APRN)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ages</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 years or older at the start of the measurement period AND less than 18 years at the end of the measurement period</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>At least one face-to-face well child visit (Adolescent Well Child Visit Value Set) with an eligible provider in an eligible specialty during the measurement period</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Denominator</th>
</tr>
</thead>
<tbody>
<tr>
<td>The eligible population</td>
</tr>
</tbody>
</table>
### Numerator

The number of patients in the denominator who completed ANY of the following mental health and/or depression screening tools during the measurement period, AND have the screening tool result documented in the medical record:

- Patient Health Questionnaire – 9 item version (PHQ-9)
- PHQ-9M Modified for Teens and Adolescents
- Kutcher Depression Scale (KADS)
- Beck Depression Inventory II (BDI-II)
- Beck Depression Inventory Fast Screen (BDI-FS)
- Child Depression Inventory (CDI)
- Child Depression Inventory II (CDI-2)
- Patient Health Questionnaire – 2 item version (PHQ-2)
- Pediatric Symptom Checklist – 17 item version (PSC-17) - parent version
- Pediatric Symptom Checklist – 35 item (PSC-35) - parent version
- Pediatric Symptom Checklist – 35 item Youth Self-Report (PSC Y-SR)
- Global Appraisal of Individual Needs screens for mental health and substance abuse (GAIN-SS)

### Required Exclusions

The following exclusions must be applied to the eligible population:

- Patient had a diagnosis of schizophrenia (Schizophrenia Value Set)
- Patient had a diagnosis of bipolar disorder (Bipolar Disorder Value Set)
- Patient had a diagnosis of depression or dysthymia (Major Depression or Dysthymia Value Set)
- Patient had a diagnosis of personality disorder (Personality Disorder Value Set)
- Patient had moderate, severe or profound intellectual disabilities (Intellectual Disability Value Set)

### Measure Scoring

Rate/Proportion

### Interpretation of Score

Higher score indicates better quality

### Measure Type

Process
2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening Measure Specifications

Measure Logic / Flow Chart

Is the patient’s date of birth between 01/01/1999 to 01/01/2004?

Yes  

Does the patient medical record have documentation of any diagnosis which requires exclusion from the measure?

Yes  

PATIENT NOT INCLUDED IN MEASURE

No  

No

Was the patient seen by an eligible provider in an eligible specialty during the measurement period (01/01/2016 to 12/31/2016) for at least one face-to-face well child visit (Adolescent Well Child Visit Value Set)?

Yes  

PATIENT INCLUDED IN DENOMINATOR

No

Was the patient administered an accepted mental health and/or depression screening tool during the measurement year?

Yes  

Is the result of the administered screening tool documented in the patient medical record?

Yes  

PATIENT INCLUDED IN NUMERATOR

No
### Process and Timeline Overview

<table>
<thead>
<tr>
<th>Process Step</th>
<th>Important Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration</td>
<td>December 2016 to February 2017.</td>
</tr>
<tr>
<td>Registration must be completed prior to data submission. Please refer to the Clinic and Provider Registration Instructions guide available on the Resources tab of the MNCM Data Portal as well as on MNCM.org for additional information.</td>
<td></td>
</tr>
<tr>
<td>Pre-Submission Data Certification</td>
<td>Submit document by April 3, 2017.</td>
</tr>
<tr>
<td>See Section I for more information.</td>
<td></td>
</tr>
<tr>
<td>Data Collection and Submission</td>
<td>MNCM Data Portal is open for submission April 3 to May 12, 2017.</td>
</tr>
<tr>
<td>See Sections II and III for more information.</td>
<td></td>
</tr>
<tr>
<td>Preliminary Results Review, Quality Checks</td>
<td>May and June 2017.</td>
</tr>
<tr>
<td>See Sections III-B and IV for more information.</td>
<td></td>
</tr>
<tr>
<td>Data Validation (Audits)</td>
<td>June and July 2017.</td>
</tr>
<tr>
<td>See Section IV for more information.</td>
<td></td>
</tr>
<tr>
<td>Two-Week Medical Group Review Period</td>
<td>July 2017</td>
</tr>
<tr>
<td>See Section IV for more information.</td>
<td></td>
</tr>
<tr>
<td>Final Data Results</td>
<td>Fall 2017</td>
</tr>
</tbody>
</table>

### Sharing Data Files and Protected Health Information (PHI) Securely:

It is important that data files and PHI are shared securely between organizations. Email is not a secure mode of transmitting data.

- Do not send a data file or patient list that contains PHI to MNCM via email.
- Do not include any identifiable patient information in the body of an email message.
  - Examples of PHI include (but are not limited to) the following: patient ID, patient date of birth, patient name, patient address or zip code, insurance member ID, dates of service.

Please contact support@mncm.org to determine a secure mode of transmission.
Data Submission Resources

The Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening resources page contains useful documents and answers to Frequently Asked Questions. To access the resources page:

1. Log in to the [MNCM Data Portal](https://data.mncm.org/login).
2. Click on the Resources tab.
3. Select **Cycle B – Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening** from the drop down menu.
   a. Download the following documents:
      i. *Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening 2017 Data Collection Guide*
      ii. *Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening 2017 Pre-Submission Data Certification Form*
      iii. *Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening 2017 Data Collection Spreadsheet Template*
      iv. **Optional**: *Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening 2017 Data Collection Form*. This is a patient-level form that is most useful for medical groups and clinics using paper records.
      v. *2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening Value Set Dictionary*. This workbook contains all Value Sets referenced in this guide.

For questions not answered by the information available on the Resources tab, contact MNCM at [support@mncm.org](mailto:support@mncm.org) or 612-746-4522.
Direct Data Submission
Process Steps
for
2017 Pediatric Preventive Care:
Adolescent Mental Health and/or Depression Screening
Section I: Agreements and Pre-Submission Data Certification

Clinic and provider registration as well as the electronic signing of the Business Associate Agreement (BAA), the Direct Data Submission (DDS) Terms and Conditions, and selection of a Data File Transfer option must be completed prior to data submission.

A. Business Associate Agreement

A business associate is a person or entity that performs certain functions or activities that involve the use or disclosure of PHI on behalf of, or provides services to, a covered entity. The HIPAA Privacy Rule requires that a covered entity obtain satisfactory assurances from its business associate that the business associate will appropriately safeguard the PHI it receives on behalf of the covered entity. Since MNCM is performing services on behalf of medical groups submitting data that involve the use and disclosure of PHI, it is necessary for covered entities submitting PHI to MNCM to sign a BAA.

To electronically sign the BAA:

1. Click on the Home tab.
2. Click on the BAA Agreement link under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening measure heading.
3. Review the text, click the check box at the bottom of the Agreement and click OK.
   a. Once electronically signed, the Agreement applies to all DDS measures and does not need to be signed again unless provisions of the Agreement change.
   b. Failure to electronically sign the Agreement will preclude the medical group from submitting data.

B. Direct Data Submission Terms and Conditions

Please see Appendix A for detailed information about the DDS Terms and Conditions.

To confirm agreement with the DDS Terms and Conditions:

1. Click on the Home tab.
2. Click on the DDS Terms & Conditions link under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening measure heading.
3. Review the text, click the check box at the bottom of the DDS Terms and Conditions and click Select.
   a. Failure to agree to the DDS Terms and Conditions will preclude the medical group from submitting data for the measure.
C. Data File Transfer Selection

Beginning in 2014, the Minnesota Department of Health (MDH) has requested the receipt of patient level data. MDH has assured MNCM that medical groups are permitted to disclose this patient-level data to MDH under applicable law (including Minnesota law and HIPAA), because it will be used by MDH only for public health activities, health oversight activities, or other activities required or authorized by state or federal law. A list of the data elements to be shared with MDH for each measure is available in the MNCM Data Portal under the Resources tab by selecting Minnesota Statewide Quality Reporting and Measurement System from the drop-down menu.

MDH will use patient level data to:

- Research and analyze health disparities
- Design and evaluate public health interventions
- Publicly report summary results
- Research risk adjustment methodologies
- Benchmark and evaluate Health Care Homes
- Validate quality measure results

MDH will not use patient level data to pursue investigatory or regulatory activities.

Medical groups must indicate on the MNCM Data Portal whether they choose to allow MNCM to share patient-level data with MDH.

1. Click on Data Files Transfer on the Home tab in the MNCM Data Portal under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening section.
2. Choose one of the two data sharing options:
   - YES – My organization agrees to have MNCM share our patient-level data with MDH for specified measures.
   - NO – My organization does not agree to have MNCM share our patient-level data with MDH.
3. Click Save.

If a selection error is made, please contact MNCM at support@mncm.org to request a selection change.
D. Pre-Submission Data Certification

To aid medical groups in the identification of the correct eligible patient population, MNCM will review each medical group’s source code and/or methodology for producing the eligible population. Medical groups document the methodology and source code on a template provided by MNCM and upload the template to the MNCM Data Portal for review. This standard template is provided to ensure that all medical groups are using the same required set of criteria to identify the eligible population. MNCM recommends that medical groups complete this review process prior to using the source code and/or methodology to identify the eligible population and collect data.

This review process is intended to identify potential issues prior to data submission, thus avoiding rework for medical groups; however, the responsibility to submit an accurate eligible population rests with the medical group.

To download and complete the template and submit it for certification:

1. Login to the MNCM Data Portal.
2. Under the Resources tab, select Cycle B – Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening from the drop-down menu.
3. Download the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening Pre-Submission Data Certification Form.
4. Complete and save the form.
5. Login to the MNCM Data Portal and from the Home page click on Denominator Certification under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening header. Follow the instructions to upload the saved form to the MNCM Data Portal.

MNCM will review the information and will either (1) contact the medical group if more clarification is needed or (2) certify the methodology. An automatic e-mail will notify the medical group when the method is certified.
Section II: Data Collection

A. Eligible Population Identification

After Pre-submission Data Certification is complete, medical groups may query their systems to identify the eligible population. This step must be completed regardless of whether the group plans to submit total population or a sample of eligible patients. MNCM recommends saving all original queries, spreadsheets and other documentation of the process used to identify the eligible population for potential review. This information may be requested during validation.

Preparing the eligible population list:

1. **Query** your system to generate a list according to the eligible population as described in the measure specifications.

2. **Remove** patients from the list who meet any of the criteria described in the required exclusions section of the measure specifications.

3. **De-duplicate** the list; include only one record for each patient. If a patient is listed more than once within a clinic or the entire medical group as registered in the MNCM Data Portal, determine which provider or clinic the patient will be attributed to and delete the other patient medical record/row.
   - Organizations with more than one registered medical group must report patients within each medical group for which the patient has met eligibility criteria; duplication of patients across the organization is possible and expected.
   - See Appendix E for the definition of medical group.

4. **Review** the number of patients in the population and consider whether the number is accurate. If not, correct the methodology and/or query.

Total Population (recommended)

Per the EMR Reporting Rule established by the Minnesota Department of Health (MDH), clinics that have had an Electronic Medical Record (EMR) or Electronic Health Record (EHR) in place at any stage for the last two measurement periods are required to submit data on their total population. MNCM strongly encourages all clinics to submit data on their total eligible population, when possible. Benefits include:

- **More reliable performance scores.** Performance measurement scores based on total population data more reliably reflect the quality of care delivered by a clinic and medical group. Reliability depends on the degree of random measurement error and the size of the population or sample. As the population size in a data submission increases, the margin of error for reporting differences in performance narrows. Performance scores calculated from sample population data will have a larger margin of error.
Sample Population
Submission of a sample population for this measure is allowed for clinics that do not have an EMR or have had an EMR in place for less than two years. See Appendix C for instructions on identifying a random sample of patients. A sample size of at least 60 records per clinic is required. Clinics with 60 or less eligible patients must submit data for the total population.

Patient Attribution
Each patient is attributed to the provider and clinic associated with the most recent well-child visit during the measurement period.

If a provider has left the clinic/medical group, the patient must remain in the data file if they meet eligibility criteria.

B. Data Collection
After the eligible population is identified, data will need to be collected for the elements listed in the Data Elements and Field Specifications table.

Data collection occurs after:
1. The clinic’s billing and medical record updates are complete for the measurement period;
2. The patient identification methodology is certified by MNCM; and
3. The total eligible population list is prepared.
   a. If applicable, a sample is selected according to the measure specifications and sampling instructions (Appendix C).

The medical record is considered the true source of information. Administrative claims data or documentation outside of the medical record may be useful in the identification of patient characteristics and/or data collection of specific data elements. However, upon audit, submitted data elements will be verified against the medical record regardless of the use of other information in the preparation of the data file for submission.

Data Collection: Using Multiple Data Abstractors
For medical groups that must collect data via manual chart abstraction, MNCM recommends that one data abstractor is used, when possible. If more than one abstractor is needed, maximize inter-rater reliability (IRR) by training all abstractors about the definitions of each data element and about the location of clinical information in the patient record.
Data Elements and Field Specifications
Use this section to build your data file for submission. The specifications contain detailed information regarding each column in the submission file, including column order, definitions, examples, and appropriate formatting.

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Clinic ID</td>
<td>Enter the <strong>MNCM Clinic ID</strong> of the clinic to which the patient is attributed based on the attribution methodology detailed in Section II. MNCM assigns clinic IDs at the time of registration. Clinic IDs are listed in the MNCM Data Portal on the Clinics tab. Do NOT use the medical group ID. A blank field will create an ERROR upon submission. <strong>Quality Check:</strong> Verify that the ID in each cell matches the clinic ID in the MNCM Data Portal.</td>
<td>Text</td>
<td>9999</td>
</tr>
</tbody>
</table>
| B      | Patient ID | Enter a unique patient ID to identify each patient. The patient’s medical record number may be used. Medical groups or clinics that choose not to use the medical record number should:  
  - NOT use the patient’s Social Security Number  
  - Maintain a crosswalk between the patient ID and the medical record number or patient name and Date of Birth (DOB)  
Medical groups or clinics that do not have an EHR should also maintain a crosswalk between patient ID and patient name and DOB as a tool to locate records during audit.  
A blank field will create an ERROR upon submission. **Quality Check:** Verify that there are not any duplicate patients. If a patient has multiple records (rows), determine which clinic the patient should be attributed to and delete the duplicate record(s). If submitting a sample population, you will need to replace the deleted record with the next patient listed in the random sample. | Text         | 1       |
### 2017 Pediatric Preventive Care:
#### Adolescent Mental Health and/or Depression Screening
#### Data Collection

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Patient Date of Birth</td>
<td>Enter the patient’s date of birth. Patient must be 12 years or older at the start of the measurement period AND less than 18 years at the end of the measurement period.</td>
<td>Date (mm/dd/yyyy)</td>
<td>10/13/2000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The date of birth range for this age group is between 01/01/1999 to 01/01/2004.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>A blank field or a value outside of the allowable range will create an ERROR upon submission.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that each date of birth is within the accepted range.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Gender</td>
<td>Enter the patient’s gender:</td>
<td>Text</td>
<td>F</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Female = F       Male = M   Unknown = U</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unknown should be utilized for transgender or androgynous patients or in situations when the patient’s gender is not available in the record.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>A blank field will create an ERROR upon submission.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that each cell has an accepted code.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Zip Code_Primary Residence</td>
<td>Enter the five-digit zip code of the patient’s primary residence at the most recent encounter on or prior to 12/31/2016.</td>
<td>Text</td>
<td>55111</td>
</tr>
<tr>
<td></td>
<td>CHANGE for 2017</td>
<td>• If extraction results in a nine-digit zip code, all nine-digits may be submitted. The MNCM Data Portal will only store the first five digits.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>A blank field will create an ERROR upon submission.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Quality Check:</strong> Verify that the zip code is at least five digits and that each cell has a value.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening Data Collection

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Race/Ethnicity 1</td>
<td>Please refer to a separate document entitled <em>REL Data Elements, Field Specifications &amp; Codes</em> for Column F-N field definitions and specifications. This document can be found in the MNCM Data Portal under the Resources tab in the Race/Ethnicity/Language Data (REL) section, or on <a href="https://data.mncm.org/login">MNCM.org</a> under Submitting Data &gt; Training and Guidance &gt; Data Collection Guides.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>G</td>
<td>Race/Ethnicity 2</td>
<td></td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>H</td>
<td>Race/Ethnicity 3</td>
<td>For more information about collecting this data from patients, refer to the <em>Handbook on the Collection of Race Ethnicity and Language Data</em> available on <a href="https://data.mncm.org/login">MNCM.org</a> under Submitting Data &gt; Training &amp; Guidance &gt; Data Collection Guides.</td>
<td>Text</td>
<td>CountryA</td>
</tr>
<tr>
<td>I</td>
<td>Race/Ethnicity 4</td>
<td><strong>Quality Check:</strong> Verify that each cell has an accepted code. Blank cells (if data is not available) are acceptable.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>J</td>
<td>Race/Ethnicity 5</td>
<td></td>
<td>Text</td>
<td>LanguageB</td>
</tr>
<tr>
<td>K</td>
<td>Country of Origin Code</td>
<td></td>
<td>Text</td>
<td>CountryA</td>
</tr>
<tr>
<td>L</td>
<td>Country of Origin Other Description</td>
<td><strong>CHANGE for 2017</strong></td>
<td>Text</td>
<td>LanguageB</td>
</tr>
<tr>
<td>M</td>
<td>Preferred Language Code</td>
<td><strong>Quality Check:</strong> Verify that each cell has an accepted code. Blank cells (if data is not available) are acceptable.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>N</td>
<td>Preferred Language Other Description</td>
<td><strong>CHANGE for 2017</strong></td>
<td>Text</td>
<td>LanguageB</td>
</tr>
<tr>
<td>O</td>
<td>Provider NPI</td>
<td>Enter the 10 digit National Provider Identifier (NPI) of the provider to which the patient is attributed based on the attribution methodology detailed in Section II. If the provider does not have an NPI, enter the provider ID as registered in the MNCM Data Portal. A blank field will create an ERROR upon submission.</td>
<td>Text</td>
<td>1234567891</td>
</tr>
</tbody>
</table>
## 2017 Pediatric Preventive Care:
Adolescent Mental Health and/or Depression Screening
Data Collection

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Provider Specialty Code</td>
<td>Enter the specialty code of the physician. If the provider is not a physician, enter the specialty code of the supervising physician. 1 = Family Medicine 2 = Internal Medicine 24 = Pediatric/Adolescent Medicine A blank field will create ERRORS upon submission. <strong>Quality Check:</strong> Verify that each cell has an accepted code.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>Q</td>
<td>Insurance Coverage Code</td>
<td>Please refer to a separate document entitled <em>Insurance Coverage Data Elements, Field Specifications &amp; Codes</em> for these field specifications. This document can be found via the link above, in the MN Community Measurement Data Portal under the Resources tab in the Insurance Coverage Field Specifications &amp; Codes for DDS section, or on <a href="http://www.MNCM.org">MNCommunity.org</a> under Submitting Data &gt; Training and Guidance &gt; Data Collection Guides. • Enter codes corresponding to the patient’s most recent insurance on or prior to 12/31/2016. <strong>Quality Check:</strong> Verify that each cell has an accepted code and that all 99 codes have a name entered in Column R. Verify that Social Security Numbers are NOT submitted.</td>
<td>Number</td>
<td>1</td>
</tr>
<tr>
<td>R</td>
<td>Insurance Coverage Other Description</td>
<td><strong>CHANGE for 2017</strong> <strong>WORKERS COMPENSATION ONLY</strong></td>
<td>Text</td>
<td>WORKERS COMPENSATION ONLY</td>
</tr>
<tr>
<td>S</td>
<td>Insurance Plan Member ID</td>
<td><strong>Quality Check:</strong> Verify that each cell has an accepted code and that all 99 codes have a name entered in Column R. Verify that Social Security Numbers are NOT submitted.</td>
<td>Text</td>
<td>FBOXZ7969</td>
</tr>
<tr>
<td>T</td>
<td>Well-Child Visit Date</td>
<td>Enter the date of the most recent well-child visit during the measurement period. A blank field will create an ERROR upon submission. <strong>Quality Check:</strong> Verify that the date is during the measurement period.</td>
<td>Date (mm/dd/yyyy)</td>
<td>10/30/2016</td>
</tr>
</tbody>
</table>

Helpline: 612-746-4522 | E-mail: support@mncm.org | MN Community Measurement Data Portal: [https://data.mncm.org/login](https://data.mncm.org/login)
© MN Community Measurement, 2016. All rights reserved.
### 2017 Pediatric Preventive Care:
Adolescent Mental Health and/or Depression Screening
Data Collection

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>Mental Health or Depression Screening Date</td>
<td>Enter the date that the patient received a mental health and/or depression screening during the measurement period. If the patient received more than one screening during the measurement period, submit the date of the most recent screening. Leave BLANK if the patient did not have a mental health and/or depression screening with one of the acceptable tools detailed in Column V. <strong>Quality Check:</strong> Verify that the date is during the measurement period.</td>
<td>Date (mm/dd/yyyy)</td>
<td>10/30/2016</td>
</tr>
</tbody>
</table>
### 2017 Pediatric Preventive Care:
**Adolescent Mental Health and/or Depression Screening Data Collection**

<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
</table>
| V      | Mental Health or Depression Screening Tool | Indicate which mental health and/or depression screening tool was administered. If the patient received more than one screening during the measurement period, submit the most recent tool that corresponds to the date in Column U.  
1 = Patient Health Questionnaire - 9 item version (PHQ-9)  
2 = PHQ-9M Modified for Teens and Adolescents  
3 = Kutcher Depression Scale (KADS)  
4 = Beck Depression Inventory II (BDI-II)  
5 = Beck Depression Inventory Fast Screen (BDI-FS)  
6 = Child Depression Inventory (CDI)  
7 = Child Depression Inventory II (CDI-2)  
8 = Patient Health Questionnaire - 2 item version (PHQ-2)  
9 = Pediatric Symptom Checklist - 17 item version (PSC-17) - parent version  
10 = Pediatric Symptom Checklist - 35 item version (PSC-35) - parent version  
11 = Pediatric Symptom Checklist - 35 item Youth Self Report (PSC Y-SR)  
12 = Global Appraisal of Individual Needs screens for mental health and substance abuse (GAIN-SS)  
See Appendix D for a comprehensive description of validated tools.  
Leave BLANK if the patient did not have a mental health and/or depression screening with one of the above listed tools.  
**Quality Check:** Verify that each cell has an accepted code. | Number       | 8                                  |
<table>
<thead>
<tr>
<th>Column</th>
<th>Field Name</th>
<th>Notes</th>
<th>Excel Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Result of Tool</td>
<td>Enter the total score (result) from the mental health and/or depression screening tool administered. If the patient received more than one screening during the measurement period, submit the result of the most recent tool that corresponds to the values in Columns U and V. If Column V has an accepted code, then a blank field will create an ERROR upon submission. <strong>Quality Check:</strong> Verify that the result is within the valid range for the tool that is identified in Column V.</td>
<td>Number</td>
<td>15</td>
</tr>
</tbody>
</table>
C. Data Quality Checks
MNCM recommends that medical groups complete several quality checks of the data prior to file upload. Quality checks improve data accuracy, reduce the likelihood of errors, and ensure that the data can be successfully validated upon audit.

Quality Check 1: File Check
Use Excel’s AutoFilter feature to complete data quality checks of specific data elements in the Excel file. To set the filter and review specific data elements:

1. Click inside any data cell and activate the AutoFilter by:
   a. In Excel 2003, click the Data menu, point to Filter, and then click AutoFilter.
2. Click on the drop-down boxes of any column and scan for key entry errors, “out-of-range” or missing data and determine if the data needs to be corrected.

Quality Check 2: Verify Clinical Data
Verify the collected clinical data by reviewing a small sample of records (eight to 10) to compare with the documentation within the patients’ medical records. If errors are identified, make the corrections in the data file. Also consider whether the errors were isolated or indicative of a larger data collection problem.

Quality Check 3: General
Complete the general quality checks outlined below:

1. Complete the quality checks listed in the Notes section of each data element in the Data Elements and Field Specifications table.
2. Verify that excluded records were removed.
3. Verify that all fields intended to be left blank are indeed blank. Do NOT enter hyphens or zeroes.
4. Remove blank rows at the bottom of the Excel spreadsheet.
   a. Press Ctrl/End to go to the bottom-most cell in the spreadsheet. If there are blank rows, highlight them, right-click in the left margin, and select Delete.
Section III: Data Submission

A. Data File Creation

Before proceeding with the file submission, be sure to:

- Complete all data collection and data entry.
- Complete data quality checks.
- Combine all clinic files onto one spreadsheet. All clinics in a medical group must be uploaded in one, single file. The clinic identifier is the Clinic ID.
- Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or DATE formatting). Columns can be any width.
- Verify that all original columns remain in the spreadsheet even if there is no data in a column. Do NOT delete any columns.

Once the above steps are completed:

1. Save the Excel template.
2. Save the file in CSV format.
   a. The CSV file will be the data file uploaded to the MNCM Data Portal.

How to create a CSV file from an Excel file:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the original Excel file (.xls).</td>
<td>3. Click the Office Button (upper left-hand corner of screen); select Save As.</td>
<td>3. Click the File tab (upper left-hand corner of screen); select Save As.</td>
</tr>
<tr>
<td>2. Activate the worksheet to be uploaded by clicking the worksheet tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Click File, Save As.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Navigate to the folder where the file will be saved.</td>
<td>4.</td>
<td>4.</td>
</tr>
<tr>
<td>5. Enter the file name.</td>
<td>At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type drop-down.</td>
<td></td>
</tr>
<tr>
<td>6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type drop-down.</td>
<td>Click Save. The following warning will appear: “...may contain features that are not compatible with CSV. Do you want to keep the workbook in this format?” Click Yes.</td>
<td></td>
</tr>
<tr>
<td>7. Click Save. The following warning will appear: “...may contain features that are not compatible with CSV. Do you want to keep the workbook in this format?” Click Yes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:

1. Open the original Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
B. Data Submission

Data Submission
Click on **Data Submission** on the Home tab in the MNCM Data Portal under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening section. Use the following steps to submit data to MNCM.

**Step 1: Enter Denominator**
Using the instructions below, manually enter denominator counts and information or complete and upload a file with this information. Whether done manually or via a file upload, the information must be completed for each clinic row. Once the information is populated, click on **Save and Continue**.

**Manual Entry:**
- **Method Used for Data Collection**: Select one of the methods from the drop-down box.
- **REL Data Collection**: Indicate if collection of race, Hispanic ethnicity, preferred language and country of origin occurred using best practice methods. Best practice methods include:
  - **Race: Reporting Multiple Races**: NOT using a multi-racial category, allowing patients to select more than one race AND using a system that allows the collection and reporting of more than one race for each patient.
- **Number of Eligible Patients (Exclusions Removed)**: Enter the number of patients who are eligible or met the inclusion criteria for the measure.
  - Do NOT include patients who met a required exclusion (e.g., bipolar disorder). Including excluded patients in this count will decrease the final rate, so remember to subtract these patients from the count.
  - If submitting a sample, the number of eligible patients must be higher than the number entered in the next field (Number of Patients Submitting).
- **Number of Patients Submitting**: Enter the number of patients in the clinic that are being submitted.
  - For total population submission, enter the same number as what was entered for Number of Eligible Patients.
  - For a sample submission, enter the number of patients being submitted.
  - Whether submitting a total or sample population, this number must match the count of patients in the data file.
- **Not Reporting**: Check this box if a clinic is not reporting any data for this cycle of data collection.
  - Provide a reason that the clinic is not reporting (e.g., no patients meet eligibility criteria).
  - Please be advised that MNCM’s policy requires ALL clinic sites within a medical group to submit their data through the DDS process. Likewise, this is a condition of participation in Minnesota Bridges to Excellence (BTE) and other pay-for-performance programs.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2016. All rights reserved.
File Upload:
1. Click on Download the Denominator Worksheet.
   • Clinic names will display in Column A and clinic IDs will display in Column B.
2. Complete the worksheet by entering the following information for each clinic:
   • **Method Used for Data Collection (Column C):** Enter the appropriate code for each clinic ID.
     1 = EMR: All data pulled via query
     2 = Manual: Paper records only
     3 = Manual: EMR and paper record
     4 = EMR: Some data looked up manually
     5 = EMR: All data looked up manually
   • **REL Data Collection (Columns D – G):** Indicate if collection of race, Hispanic ethnicity, preferred language and country of origin occurred using best practice methods. Best practice methods include:
     o **Race: Self-Report:** Allowing patient to self-report their race and Hispanic ethnicity.
     o **Race: Reporting Multiple Races:** NOT using a multi-racial category, allowing patients to select more than one race AND using a system that allows the collection and reporting of more than one race for each patient.
     o **Language: Self-Report:** Allowing patient to self-report preferred language.
     o **Country: Self-Report:** Allowing patient to self-report country of origin.
     For each clinic ID indicate if best practices are used by using the following:
     1 = Yes, we follow the best practice.
     0 = No, we do not follow the best practice.
     o Column D: Enter the appropriate code (1 or 0) to indicate if patients are allowed to self-report race and Hispanic ethnicity.
     o Column E: Enter the appropriate code (1 or 0) to indicate if clinic is NOT using a multi-racial category, allowing patients to select more than one race AND using a system that allows the collection and reporting of more than one race for each patient.
     o Column F: Enter the appropriate code (1 or 0) to indicate if patients are allowed to self-report preferred language.
     o Column G: Enter the appropriate code (1 or 0) to indicate if patients are allowed to self-report country of origin.
   • **Number of Patients that Meet Inclusion Criteria (Less exclusions) (Column H):** Enter the number of patients who are eligible or met the inclusion criteria for the measure for each clinic ID.
     o Do NOT include patients who met a required exclusion (e.g., bipolar disorder). Including excluded patients in this count will decrease the final rate, so remember to subtract these patients from the count.
     o If submitting a sample, the number of eligible patients must be higher than the number entered in the next field (Number of Patients Submitting).
2017 Pediatric Preventive Care:  
Adolescent Mental Health and/or Depression Screening 
Data Submission

- **Number of Patients Submitting (Column I):** Enter the number of patients in the clinic that are being submitted for each clinic ID.
  - For total population submission, enter the same number as what was entered for the Number of Eligible Patients.
  - For a sample submission, enter the number of patients being submitted for the sample.
  - Whether submitting a total or sample population, this number must match the count of patients in the data file.

- **Not Reporting (Column J):** Please indicate if a clinic is not reporting any data for this cycle of data collection by entering the following code.
  0 = Clinic is reporting  
  1 = Clinic is NOT reporting  
  - Please be advised MNCM’s policy requires clinic sites within a medical group to submit their data through the DDS process. Likewise, that is a condition of participation in BTE and other pay-for-performance programs.

- **Reason not reporting (Column K):** Provide a reason that the clinic is not reporting (e.g., no patients meet eligibility criteria).

3. Save the Excel file as a CSV file (see Section III - A for more information). Click **Browse** to search and find the CSV file and then click **Submit File**.

**Step 2: Review & Save**
Verify the numbers entered by reviewing all of the clinic site’s information for accuracy (no typos or duplicate patients). Click **Save and Continue**, or click **Back to Step 1** to make corrections.

**Step 3: Upload Data**
Click **Browse** to search for the CSV file and click **Upload CSV and Continue**. The MNCM Data Portal will scan the CSV file to identify possible errors. The Data Portal will then provide an upload status that will indicate if there are errors or warnings in the data file. Click on the **Refresh** link to view an updated upload status. To view errors and warnings, click **View Errors & Warnings**. If there are errors, the data file will need to be corrected and resubmitted to the MNCM Data Portal. Refer to the Data Elements and Field Specifications to review the required data specifications for each column.

- **Errors:** Corrections must be made and a corrected file uploaded (e.g., date of birth is out-of-range). Proceed to instructions below.

- **Warnings:** Closely review these possible errors and decide whether corrections are needed. If corrections to the data file are necessary, proceed to instructions below. If corrections are not necessary, click **Continue to Step 4**.
If corrections to the data file are necessary, make corrections in the original Excel file and save the corrected file. Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.

- To re-enter population counts and upload the corrected file starting from Step 1: Enter Denominator click Clear & Start Over. Note: All denominator count entries and a new file upload will be necessary if Clear & Start Over is clicked.

- If corrections are only needed to the data file click Re-Upload Data (csv) file. Begin with Step 3: Upload Data.

Once the Data (CSV) File has been successfully uploaded to the Data Portal, click Continue to Step 4.

**Step 4: Review & Submit**

Review the quality checks for each item listed in the Data Elements and Field Specifications table as well as the preliminary results and their comparison to the previous measure period’s results to determine if there are errors in the data.

- To resubmit the data file only, click Re-Upload Data (CSV) File.
- To resubmit the denominator counts and the data file, click Clear & Start Over at the bottom of the page.

Again, make corrections in the original Excel file and save the corrected file with a new name. Then save as a new CSV file to upload. Do NOT make corrections in the CSV file as this will alter the data.

Once the data has been successfully submitted, review and check each box of the Pre-Submission Quality Checklist. Click Continue. The page will be refreshed.

**Data Comparison Notes**

MNCM requests medical groups review the preliminary results for accuracy.

1. Review the following columns of information:
   - **Number of Patients That Meet Inclusion Criteria (Less Exclusions)** – This column contains the number of patients in the eligible population for the current and previous submission.
   - **Rate** – This column contains rate results for the current and previous submission; other columns show the individual component results.

2. Compare the group and individual clinic results (population and rates) to the prior submission.

Using the text box provided, describe reasons for any substantial changes. **This is a required field.** Comments in this field inform MNCM about reasons for the changes and avoids additional follow-up. After the text box is completed, click “Save Notes.”
If additional time is needed for review click “Save as Draft”. To access the submission again, click on **Data Submission** under the Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening section on the Home tab.

Contact [support@mncm.org](mailto:support@mncm.org) for assistance.

**NOTE:** If this is the first data submission for this measure or if there have been substantial changes to the measure itself, the Data Comparison Notes text box will not display.

**When the data is ready to submit to MNCM:** Click **Submit Data to MNCM** and proceed to **Step 5: Done**.

The **Submit Data to MNCM** button will not appear until the Pre-Submission Quality Checklist and Data Comparison Notes steps have been completed as stated above.

**Step 5: Done**
The data file has been successfully submitted. The MNCM Data Portal will generate an e-mail confirming receipt.

To download a report of patient level numerator compliance information, click **Download Data** near the top of the data comparison section. Columns on the far right of the report indicate which patients were included in the numerator (1) and which were not (0).
Section IV: Data Validation

After data is submitted, MNCM completes the following validation steps. Each step is critical to ensure results are accurate and comparable.

Quality Checks
MNCM completes quality checks of the demographic data, eligible population and preliminary performance results. If errors are identified, the medical group must make corrections to the data file and resubmit.

Validation Audit
All medical groups are subject to an audit. Medical groups selected for an audit are contacted by MNCM. A list of records for audit will be provided. Other audit preparations:

- The medical group or clinic site representative must be available to participate in the entire audit process.
  - For data that resides in an electronic record, the audit will be conducted via a HIPAA secure, online meeting service; the medical group or clinic representative will need to retrieve and display the selected records and screens necessary to complete the audit.
  - For data that resides in a paper record, the audit will take place onsite.
- Patient names or other personal information may be blinded. MNCM will verify the record is correct using the date of birth that was submitted.
- The following items must be available for the audit:
  - ALL requested patient records.
  - The “crosswalk” between the unique patient identifier and the patient’s name and date of birth, as necessary.
  - Data collection forms and other notes describing where various data elements were located in the patient record.
  - List of patients that were excluded.

NCQA 8 and 30 Audit Process
MNCM utilizes the National Committee for Quality Assurance (NCQA) “8 and 30” process for audits.

- MNCM randomly selects 33 records from each applicable clinic site for validation. At most, 30 records for each clinic site will be reviewed. The additional three records are oversamples to ensure 30 records will be available on the day of the review.
- The MNCM auditor reviews records one through eight in the sample to verify whether the submitted data matches the source data in the medical record.
- If no errors are found in these eight records, the compliance rate is 100 percent, and the clinic site is determined to be in high compliance. The MNCM auditor may determine no further record review is necessary. The MNCM auditor communicates results to MNCM staff.
- If the auditor identifies one or more errors in these eight records, the auditor will continue auditing records nine through 30 and a compliance rate is calculated (e.g., 27/30 records compliant, 90 percent). If the compliance rate is less than 90 percent, the auditor will communicate the results with MNCM, who will contact the medical group to discuss a data resubmission plan.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2016. All rights reserved.
Two-Week Medical Group Review
The two-week medical group review is the medical group’s official opportunity to review and comment on the results prior to finalization. Each medical group is responsible for reviewing their own results, investigating any concerns, and submitting evidence to MNCM if a change in results is requested. MNCM staff will review all requests and determine an appropriate course of action. A notification about this review will be sent to the primary data contact and other key contacts registered by the medical group in the MNCM Data Portal.

After Validation
Once MNCM validation processes are complete, MNCM will approve the data in the MNCM Data Portal. An e-mail will be sent to the medical group’s data contact notifying them that the data was approved.

After all statewide results are approved, MNCM may publish clinic and medical group level results on MNHealthScores.org. Results can also be found on the MNCM Data Portal > Results tab.

Medical groups should maintain data submission files and other documents related to data submission for two years.
Appendices

Appendix A: About Direct Data Submission

The goal of Direct Data Submission (DDS) is to collect patient-level data from medical groups on specific health care conditions and publicly report comparable results of health care quality at the clinic site level. All medical groups follow the same instructions for eligible population identification and data collection. MNCM certifies methodologies prior to data collection. Then each medical group submits data to MNCM via a secure, online data portal. As an independent auditor and as a service to each medical group, MNCM validates the data for accuracy, calculates results from the validated data, and publicly reports the data on MNHealthScores.org.

Required Reporting

DDS fulfills participation requirements for the Minnesota Department of Health’s Minnesota Statewide Quality Reporting and Measurement System (SQRMS) as well as other health plan pay-for-performance programs and BTE. In addition, DDS results can be used by medical groups for quality improvement purposes.

DDS Terms and Conditions

To participate in the DDS process, medical groups must agree to:

- MNCM’s DDS Terms and Conditions (signed electronically on the MNCM Data Portal).
- Complete a Business Associate Agreement with MNCM (signed electronically on the MNCM Data Portal).
- Submit a patient-level file to the secure MNCM Data Portal that automatically calculates results.
- Participate in the data validation process as required by MNCM.
- Have results publicly reported on MNHealthScores.org and in other reports.
- Submit data for ALL clinic sites.
- Submit data in required format (CSV).
- Submit data in good faith.
- Adhere to and follow all data submission timelines and formatting specifications.

Medical groups also understand that:

- MNCM works with corresponding health plans to determine Primary payer type (Commercial/Private, Medicaid, Medicare, uninsured/self/pay) on your behalf to reduce burden.
- The BTE program and most Minnesota health plans only accept results generated from the DDS method for their incentive programs, because the patient-level results can be validated.
Compliance with Federal and State Regulations

Our legal counsel has assured us that the DDS method complies with applicable provisions of the Health Insurance Portability and Accountability Act (HIPAA), Health Information Technology for Economic and Clinical Health (HITECH) Act, and Minnesota statute as long as we are acting as a business associate to each participating medical group (e.g., by gathering and submitting data on its behalf) and have a signed BAA with the medical group. The BAA is signed electronically on the MNCM Data Portal. The BAA is signed once and remains in effect for all DDS measures.

Health Insurance Portability and Accountability Act Law:

- The activities of data collection, data submission, public reporting and use of results for quality improvement are considered within the scope of health care operations associated with the medical group quality improvement efforts.
- The federal HIPAA law specifically allows release of individually identifiable health information - without the consent or authorization of the individual - for treatment, payment and health care operations of, or for, the provider.
- MNCM’s business associate agreement has been updated to include all provisions required by the HITECH Act.

Minnesota Statute:

- The primary governing Minnesota statute is MN Stat. Section 144.335.
- Subd. 3a. entitled "Patient consent to release of records; liability" states: (a) A provider, or a person who receives health records from a provider, may not release a patient’s health records to a person without a signed and dated consent from the patient or the patient’s legally authorized representative authorizing the release, unless the release is specifically authorized by law.
- However, the statute does not restrict release (without patient authorization) to only those circumstances authorized by state law – the statute also applies to a release authorized by federal law.
- Legal counsel assures us that it is reasonable to conclude that the HIPAA privacy regulation does specifically authorize the release of such information. A covered entity is authorized by HIPAA to release patient information for, among other things, health care operations and to its business associate that is providing such health care operations on its behalf. As stated above, the services MNCM is engaged in with providers falls within the scope of health care operations, and MNCM is acting as a business associate to the medical groups when performing the services discussed above.
Appendix B: About MN Community Measurement

Mission and Vision:
The mission of MN Community Measurement is to accelerate the improvement of health by publicly reporting health care information. Our vision is that MN Community Measurement will:

- Be the primary trusted source for health data sharing and measurement;
- Drive change that improves health, patient experience, cost and equity of care for everyone in our community;
- Be a resource used by providers and patients to improve care; and,
- Partner with others to use our information to catalyze significant improvements in health.
Appendix C: Sampling Methods

Prior to pulling a random sample of patients, all patients who meet eligibility criteria must first be identified. Please see Section II for more detailed information about identifying all patients who meet eligibility criteria. After identifying the eligible population, use Method 1 or 2 in order to pull a random sample of patients from the eligible population for each clinic. The patients pulled into the random sample will be the patients who will be included in the data submission file.

Method 1: Excel Random Number Generator

1. Insert a blank column on the leftmost side of the spreadsheet.
2. Label new column RAND.
3. Place cursor in the first blank cell (A2) and type =RAND().
4. Press enter (a number like 0.793958 will appear).
5. Place the cursor back into this cell; resting over the corner to have the pointer change to a black cross, double click or drag the formula down to the last row/patient.
6. Highlight the whole column and click Edit, Copy, Paste Special = Values to freeze the random number (otherwise it will change with every click on the spreadsheet).
7. Sort entire eligible population by this new random number.
8. Work down the list row by row, starting with the first row until the number of records in the sample is met for submission (at least 60 patients per clinic, plus at least 20 oversamples = 80 patients per clinic).
9. If a patient meets one of the required exclusions, do not include the patient in the data submission. Note the exclusion reason on the data collection form and keep working down the list. Use oversample records following the last record/row of the original sample. For example, if 60 records are being submitted and two exclusions were found in the first 60 records/rows, use the patients from rows 61 and 62 to replace the excluded records/rows.

Method 2: Systematic (Nth Method) Sample Selection

1. Start with a list that has patients sorted by some unique patient related variable.
   a. An identifying number like a medical record number or chart number is ideal.
   b. Sorting alphabetically is the least desirable in terms of randomness; however, this may be used when there is no other alternative.
2. Select every Nth patient for the number of patients that will be reported. N should equal the clinic site’s total eligible population divided by the number of patients that will be submitted (if needed, round down to the nearest whole number). Highlight or mark every Nth patient on the list. This is the sample.
   a. Example: If a clinic site has 600 eligible patients and 60 patients will be submitted, divide 600/60 = 10. Select every 10th patient on the list.
3. If a patient meets one of the accepted exclusions, do not include the patient in the data submission. Note the exclusion reason on the data collection form, and select the next patient on the list (just below the excluded patient).
   a. Example: If every 10th patient on the list was selected, and the 1st patient in the sample (the patient on row 10) has an accepted exclusion reason, select the patient on row 11.
to replace the patient that was excluded. Then proceed to the next patient selected for the sample (patient on row 20).

**Missing records:** If a record in the sample is not available or missing, do NOT exclude this record. Locate the record or, if the record cannot be located, include the record and leave the data fields blank.
# Appendix D: Mental Health/Depression Instruments and Descriptions

Tables courtesy of staff at the Minnesota Department of Health and Department of Human Services

## Table 1: Depression only screeners – Highly Recommended and Public Domain

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC/CULT SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHQ-9</td>
<td>Depression and suicide risk</td>
<td>13 years to adult</td>
<td>9 items, self-reported by patient</td>
<td>Available in multiple languages</td>
<td>Reliability: No data found. Validity: Area under ROC curve .88. Sensitivity: .895 Specificity: .775 (cut-off score of &gt;11)</td>
<td>Administration is less than 5 mins. Minimum expertise necessary is not specified.</td>
<td>Free. <a href="http://www.phqscreeners.com">www.phqscreeners.com</a></td>
</tr>
<tr>
<td>KADS Kutcher Adolescent Depression Scale</td>
<td>Depression Can be used in schools, primary care, and research.</td>
<td>12-17 years</td>
<td>Versions: 16 items 11 items 6 items</td>
<td>6 item and 11 item versions are available in multiple languages. Text is in 6th grade reading level.</td>
<td>6 Item Version: Reliability: Internal consistency .90 Specificity: .71 based on cut-off score 6 (6 items) 11 Item Version: Reliability: Internal consistency .84 16 Item Version: Reliability: Internal consistency .84 All Versions: Validity: Area under (ROC) curve: .89 Sensitivity: .92</td>
<td>Administration is 5 mins and scoring is 1 min. Minimum expertise necessary is Trained health care professionals or educators.</td>
<td>Free with permission. <a href="http://www.teenmentalhealth.org">www.teenmentalhealth.org</a></td>
</tr>
</tbody>
</table>
# 2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening

## Appendices

**Table 2: Depression only screeners – Highly Recommended and Proprietary**

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC/CULT SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/AVAILABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>BDI II Beck Depression Inventory II</td>
<td>Depression and suicide risk Reflects DSM IV criteria.</td>
<td>13 years to adult</td>
<td>21 items, self-reported by patient</td>
<td>Validated in English. Available in Spanish. Text is in 6th grade reading level.</td>
<td>Reliability: Internal consistency: .92 Validity: Convergent: .84; Area under ROC curve: .78 Sensitivity: .84 Specificity: .81</td>
<td>Administration is 5 mins. Minimum expertise necessary is Master’s level or higher.</td>
<td>Proprietary. $121.50/kit*, including manual &amp; 25 record forms. <a href="http://www.pearsonassessments.com">www.pearsonassessments.com</a></td>
</tr>
<tr>
<td>BDI-FS BDI – Fast Screen</td>
<td>Depression</td>
<td>13 years to adult</td>
<td>7 items, self-reported by patient</td>
<td>Not available.</td>
<td>Reliability: Internal consistency: .89 Validity: Area under ROC curve: .90 Sensitivity: .89 Specificity: .74 (cut-off score 6)</td>
<td>Administration is less than 5 mins. Minimum expertise necessary is Master’s level or higher.</td>
<td>Proprietary. $100/kit* including manual &amp; 50 record forms. <a href="http://www.pearsonassessments.com">www.pearsonassessments.com</a></td>
</tr>
<tr>
<td>CDI Children’s Depression Inventory Original Version</td>
<td>Depression Can be used in multiple settings including primary care.</td>
<td>7-17 years</td>
<td>27 items, self-reported by patient OR 12 items, reported by teacher OR 17 items, reported by parent</td>
<td>Validated in English and Spanish. Available in multiple languages. Text is in 1st grade reading level.</td>
<td>Reliability: English Internal consistency: .83-.88; Spanish Internal consistency: .85 boys and .86 girls; Test-retest: .86. Validity: Convergent: .56-.78 Sensitivity: .94 Specificity: .84 (cut-off score 16)</td>
<td>Administration is 15 mins. Minimum expertise necessary is trained professionals and paraprofessionals.</td>
<td>Proprietary. $330/kit*, including manual and 25 each of parent, teacher forms. Multi Health Systems <a href="http://www.mhs.com">www.mhs.com</a></td>
</tr>
<tr>
<td>CDI-2 Children’s Depression Inventory, 2nd version</td>
<td>Depression Has emotional and functional scales.</td>
<td>7-17 years</td>
<td>28 items, self-reported by patient OR 10 item, self-reported by patient OR 12 items, reported by teacher OR 17 items, reported by parent</td>
<td>Validated in English. Available in Spanish. Text is in 2nd grade reading level. Norms are based on gender, racial/ethnic, geographic distribution reflecting census.</td>
<td>Reliability: internal consistency .91 (28 item youth) (.82 (10 item youth)); subscale internal consistency .76-.85 (youth), .89 (teacher), .88 (parent). Test-retest .98 (youth). Validity: No data found Sensitivity: .83 Specificity: .73</td>
<td>Administration is 15-20 mins for the 28 item scale and 5 mins for the 10 item scale. Minimum expertise necessary is not specified.</td>
<td>Proprietary. $289 for complete kit*, including manual and 25 each of long forms, short forms, parent report, &amp; teacher report. <a href="http://www.pearsonassessments.com">www.pearsonassessments.com</a></td>
</tr>
</tbody>
</table>

*Price estimates for proprietary tools obtained during measure development in 2013 and may be subject to change.*

**Helpline:** 612-746-4522 | **E-mail:** [support@mncm.org](mailto:support@mncm.org) | **MNCM Data Portal:** [https://data.mncm.org/login](https://data.mncm.org/login)

© MN Community Measurement, 2016. All rights reserved.
<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC/CULT SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/AVAILABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHQ-2 Patient Health Questionnaire – 2 item</td>
<td>Depression. Can be used as initial step prior to PHQ-9.</td>
<td>13-17 years</td>
<td>2 items, self-reported by patient</td>
<td>Validated in English.</td>
<td>Reliability: No data found. Validity: Area under ROC curve: .84 Sensitivity: .83-.87 Specificity: .78-.92</td>
<td>Administration 1 minute. Minimum expertise necessary is not specified.</td>
<td>Free, available online.</td>
</tr>
</tbody>
</table>
# Table 4: General mental health screeners – Highly Recommended or Proprietary with Permission in MN

<table>
<thead>
<tr>
<th>TOOL</th>
<th>SCREENING PURPOSE</th>
<th>AGE</th>
<th>DESCRIPTION</th>
<th>LINGUISTIC SENSITIVITY</th>
<th>PSYCHOMETRICS</th>
<th>PRACTICALITY</th>
<th>COST/ AVAILABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSC-17</td>
<td>Mental health screening and functional screening.</td>
<td>4-16 years</td>
<td>17 items reported by parent. There is a 17 item youth self-reported by patients 11 years and older; but this tool’s score is not validated and therefore cannot be recommended for use.</td>
<td>Parent tool is available in English, Spanish, Chinese, and Vietnamese. Youth tool is available in English and Spanish. Text is in 5th-6th grade reading level.</td>
<td>Parent version Reliability: Internal consistency .67-.82 Validity: Concurrent .72-.74 Sensitivity: .42-.88 Specificity: .61-.91 Youth version No data available. Do not use the youth version.</td>
<td>Administration is less than 5 mins and scoring is 1-2 mins. Minimum expertise is not specified for admin/scoring. Master degree recommended for interpretation.</td>
<td>Free <a href="http://www.massgeneral.org/psychiatry/services/psc_home.aspx">www.massgeneral.org/psychiatry/services/psc_home.aspx</a></td>
</tr>
<tr>
<td>PSC-35 (parent version)</td>
<td>Mental health screening and functional screening.</td>
<td>4-16 years</td>
<td>35 items reported by parent. 35 items reported by patients 11 years and older Either the parent version or the Youth Self-Report version can be used.</td>
<td>Validated in U.S., Japan, Austria, Chile, Philippines, and Botswana. Written versions available in multiple languages. Audio versions available in English, Hmong, Somali and Spanish.</td>
<td>Reliability: Internal consistency .91 (parent); Test-retest .84-.91 Validity: Validated per publisher Sensitivity: .68 Specificity: .95 (Parent version, cut-off score 28)</td>
<td>Time to administer is 5 mins and scoring is 1-2 mins. Minimum expertise is not specified for admin/scoring. Master degree recommended for interpretation.</td>
<td>Free <a href="http://www.massgeneral.org/psychiatry/services/psc_home.aspx">www.massgeneral.org/psychiatry/services/psc_home.aspx</a> <a href="http://www.brightfutures.org/mentalhealth/pdf/professionals/ped_sympton_chklst.pdf">www.brightfutures.org/mentalhealth/pdf/professionals/ped_sympton_chklst.pdf</a></td>
</tr>
<tr>
<td>PSC-35 YSR YSR</td>
<td>Mental health screening and functional screening.</td>
<td>4-16 years</td>
<td>20 items, self-reported by patient.</td>
<td>Available in English.</td>
<td>Reliability: Internal consistency .91 Validity: Correlation .84-.94 with full 123-item GAIN Sensitivity: .90 Specificity: .92</td>
<td>Time to administer is 10 mins. Minimum expertise necessary is minimal.</td>
<td>Proprietary; Minnesota has license for all providers to use within state.</td>
</tr>
<tr>
<td>GAIN-SS</td>
<td>Mental health disorders, substance use, crime/violence.</td>
<td>10 years to adult</td>
<td>20 items, self-reported by patient.</td>
<td>Available in English.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Highly Recommended for Depression Screening

Public domain

- Kutcher Adolescent Depression Scale (KADS).
- Patient Health Questionnaire – 9 item version (PHQ-9).
- PHQ-9 Modified for Teens and Adolescents.

Proprietary

- Beck Depression Inventory II (BDI-II).
- Beck Depression Inventory Fast Screen (BDI-FS).
- Children’s Depression Inventory (CDI) [original version].
- Children’s Depression Inventory II (CDI-2).

Highly Recommended for General Mental Health Screening

Public domain (or licensed for use in Minnesota)

- Pediatric Symptom Checklist – 17 items (PSC-17) parent version.
- Pediatric Symptom Checklist – 35 items (PSC-35) parent version.

Acceptable but Not Highly Recommended for Depression Screening

Public domain

- PHQ-2 – Limited validity data available for adolescents.

Not Recommended

Screens only for specific mental health condition other than depression

- Screen for Childhood Anxiety Related Emotional Disorders (SCARED or SCARED-R) – does not screen depression or broader mental health.
- Spence Children’s Anxiety Scale (SCAS) – does not screen depression or broader mental health.

Intended for diagnostic assessment, not screening

- Connors Rating Scales – assessment tool, not designed for universal screening.
- Vanderbilt Assessment Scales – intended for age 6-12 years in context of concern for or follow up of ADD/ADHD.
- Strengths and Difficulties Questionnaire (SDQ) – teacher report is necessary to achieve adequate sensitivity and specificity.
Not a standardized instrument or inadequate psychometric properties for use in primary care

- Brief Impairment Scale (BIS) – does not screen depression; limited validity data; no sensitivity/specificity data.
- Children’s Depression Inventory (CDI) [original] short form (10 questions) – no validity or sensitivity/specificity data found.
- Children’s Global Assessment Scale (C-GAS) – not standardized, no validation; based on prior clinical assessment.
- Short Mood Feeling Questionnaire (SMFQ) – weak convergent validity data.
Appendix E: Glossary of Terms

Standard list of terms often used in the data submission process. Not all terms apply to all measures.

**Allowable Exclusions:** Allowable exclusions are optional. A medical group may choose to remove patients from data submission who meet the criteria described in the Allowable Exclusions section of the measure specifications.

**Assignment:** The process by which clinics are assigned to clinical quality measures, for which they are then responsible to report data to MNCM. Assignments are based on specialties offered at each clinic. These specialties are selected by the medical group during clinic registration.

**Audit:** The process by which MNCM reviews and validates the data submitted to ensure the data reflects the patient record. Audits are completed on-site at a clinic or electronically.

**Calculated Exclusions:** Exclusions that are calculated by the MNCM Data Portal based on data supplied in the data file. Patients to whom a calculated exclusion applies must still be included in the data file; upon submission, the Data Portal will remove the appropriate patients from measure calculation.

**Clinic:** The individual practice site or sites that are registered under the main medical group. Clinics are locations where primary or specialty care ambulatory services are provided for a fee by one or more physicians.

A clinic site location is a building, separate space or an entity with a street address. It should be a functional unit that is easily understood by patients/consumers. The goal of reporting by clinic site is to provide patients/consumers with information about the entity with which they are most familiar and to provide information to clinics that is actionable for quality improvement purposes.

**Clinic and Provider Registration:** The annual process by which clinics and providers register on the MNCM Data Portal. Providers who worked at a clinic site during the previous calendar year must be registered. Typically this occurs annually during December and January. Please see the Clinic and Provider Registration Instructions for specific details and guidance.

**Clinic ID:** Assigned to a clinic by the MNCM Data Portal when the clinic first registers on the MNCM Data Portal.

**Clinical Staff:** Defined, for the purposes of Clinic and Provider Registration, as the following provider types: physicians (MD or DO), advanced practice registered nurses (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, and Certified Nurse Midwife) and physician assistants (PA).

**Contacts Tab:** Tab in the MNCM Data Portal that lists all contacts for a particular medical group. Medical groups can add, remove or edit contact people on this tab. While changes can be made at any time, this information must be updated by medical groups during Clinic and Provider Registration.

**Crosswalk:** Process by which a unique identifier is linked to a patient’s name and date of birth so medical records can be located by clinic staff in the case of an audit by MNCM.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2016. All rights reserved.
CSV File: Acronym for “comma separated values.” A CSV file is a common and simple format that is used to import/transport data between systems or software applications that are not directly related (e.g., from a spreadsheet to a database). All data submission files are formatted as CSV files.

Data Collection Form: Form that has all patient-level data elements necessary to collect for measure. It is optional for medical groups to use this form. It may be most useful for clinics/medical groups using paper records.

Data Collection Guides: Document providing instructions for clinics/medical groups to submit data counts or files to the MNCM Data Portal.

Data Comparison: Part of DDS process where clinics/medical groups are asked to review the current measurement period’s preliminary results for each clinic compared to the last data submission for this measure and consider any changes between the current period and the prior period. It is expected that an explanation will be entered into a text box to account for any changes or to indicate that the data comparison is expected.

Data Elements: Components necessary to submit data files to MNCM and to calculate measure results.

Data File: Excel template supplied on the MNCM Data Portal for DDS data submission. Templates are specific to and formatted correctly for each measure.

Data File Transfer Selection: MDH has requested the receipt of patient level data. Medical groups must indicate on the MNCM Data Portal if they chose to allow MNCM to share patient-level data with MDH. This is called Data File Transfer Selection. Detailed information about the Data File Transfer Selection options can be found in Section I of the data collection guides.

Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit patient-level data to MNCM for validation and accurate calculation of results.

Data Quality Checks: MNCM recommends completing several internal quality checks of the data prior to data file submission. Quality checks improve data accuracy, reduce the likelihood of errors and ensure the data can be validated upon audit. Please refer to specific data collection guides for guidance on data quality checks for each measure.

Denominator: The denominator is the bottom number in a fraction. In epidemiology, it represents a population group at risk of a specific disease. In clinical quality measurement, it is the total number of patients (or observations) included in the calculated score.

Direct Data Submission (DDS): The DDS method was developed by MNCM to allow medical groups to submit patient-level data for verification of results. In this process, medical groups upload files of patient-level clinical data and clinic results are automatically calculated by the MNCM Data Portal. MNCM validates data submitted through the DDS process before results are publicly reported.
Electronic Medical Record: A digital version of a paper chart that contains all of a patient’s medical history from one practice, which is also known as EMR or Electronic Health Record (EHR).

Eligible Population: A group of patients who have met all eligibility criteria to be included in a measure.

EMR Reporting Rule: Established by MDH, clinics that had an EMR in place (at any stage) for the last two measurement periods are required to submit data on their total population.

Errors: The error and warning report will be displayed after a patient-level data file is submitted via the MNCM Data Portal. Errors are “hard stops” in the Data Portal (e.g., dates of birth in the file are outside the date of birth range specified for a measure) that result in the submission of a file not being allowed. They must be corrected and a revised patient level data file must be uploaded to the Data Portal before submission can occur.

Excel Format: Format of Excel template columns necessary to submit data file to MNCM Data Portal.

Excel Template: See Data File.

Exclusions Template: Template available on the MNCM Data Portal for tracking excluded patients. This document will need to be uploaded to the MNCM Data Portal when the clinical data file is submitted on measures for which exclusions are tracked. MNCM will review this list and validate a selection of records during the validation audit. Please read more about the Exclusions Template in Section III.

Field Specifications: The detailed section in the data collection guides that provides instructions and guidance for the collection of required data elements for measure score calculation.

Final Results: Results calculated by the MNCM Data Portal after submission of a patient level data file after validation is completed. Final results are displayed on MNHealthScores.org.

Full-Time Equivalent (FTE): The best reflection of the time the provider practiced in a typical work week at each clinic site over the course of a calendar year. FTE information is submitted during Clinic and Provider Registration in the provider registration step. Please see the Clinic and Provider Registration Instructions guide for more information.

Group and Clinic Sites Tabs: These tabs display information about the medical group and clinic sites in the MNCM Data Portal. Information can be edited for the group or clinic sites as needed.

Home Tab: This tab displays information about all the current measures and deadlines for which the medical group is responsible.

Hospital-Based Outpatient Clinic Locations: These are included in the physician clinic definition and must be registered and report required measures.

Inactive Patients: Patients designated as inactive in a practice management system, billing system or electronic medical record must be included in the eligible population if they meet measure criteria.

Helpline: 612-746-4522 | E-Mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2016. All rights reserved.
2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening

Appendices

Insurance Coverage Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data collection guides to accurately collect and report insurance coverage data elements.

Inter-Rater Reliability (IRR): Recommended to conduct several sample audits with all abstractors for training purposes if more than one person will abstract data. This ensures measurement specifications are interpreted consistently and data is collected uniformly.

Measure Logic/Flow Charts: Used to help illustrate the identification of the eligible population and the logic of measure calculation.

Measure Specifications: Provide detailed information about each measure, including measure description, methodology, measurement period, denominator, exclusions and numerator. Located in the data collection guides that are available on MNCM.org and the MDH website.

Medical Group: The highest level of the MNCM Data Portal clinic and provider registration construct. The medical group represents a single centralized organization that operates one or more clinic sites. Organizations define the parameters of the medical group at the time of registration and may choose to divide clinics operated by the organization into more than one medical group. Medical groups with only one clinic site must enter information under both the medical group and clinic sections, even though the information will be the same. When reporting on the clinical quality measures, data for all clinic sites is submitted to MNCM in one file via the medical group.

Medical Group ID: Assigned to a medical group by MNCM when the medical group first registers on the MNCM Data Portal.

Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street address). Medical groups have the option to register a single clinic site or register each specialty as its own clinic site and then also register a main clinic site. How clinics decide to register depends on how the clinic desires to have their clinical measures publicly reported on MNHealthScores.org. Please review the Clinic and Provider Registration Instructions guide for further information about registering multi-specialty clinics.

National Provider Identifier (NPI): A unique identifier for individual providers or organizations that render health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify themselves in HIPAA standard transactions. Also referred to as Provider ID.

Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the new clinic must be registered with the medical group and must submit data with the medical group. If the new clinic uses a different practice management system, billing system or EMR, they should follow the same instructions and measure specifications to collect the data, and the medical group should include the new clinic’s data in the data submission to MNCM.
2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening

Appendices

**Number of Eligible Patients (Exclusions Removed):** Number of patients who are eligible or met the inclusion criteria for the measure with excluded patients removed for each clinic. This count should be entered into the MNCM Data Portal during data submission.

**Number of Patients Submitting:** Number of patients who are eligible and being submitted. This should be the same number as the as Number of Eligible Patients (Exclusions Removed) if submitting total population. If submitting a sample population, this is the number of patients in the sample population. This number must match the number of patients in the data file.

**Numerator:** The numerator is the top number in a fraction. In epidemiology, it represents the number of people in a population group who develop the disease of interest. In clinical quality measurement, it is the number of patients that meet all specified targets of a measure.

**Patient Attribution:** A patient is attributed to one clinic and provider that are considered to be responsible for managing the patient’s care. Please refer to specific data collection guides to review patient attribution for each measure as it they differ.

**Patient-Level Data:** Data elements required to calculate measure results. Data is submitted to MNCM Data Portal via a HIPAA-secure process.

**Patient Registries:** A tool used by some medical groups to track patient progress and for quality improvement purposes. MNCM cautions the use of patient registry information for quality measures. Many registries give a “snapshot” of patients at a given time and would therefore not include all patients according to established patient criteria or may not reflect the most recent clinical data (e.g., most recent blood pressure or labs). Registries that are programmed to update the patient population and clinical results on a continual basis (24/7) could possibly be used to create data file for submission; however, please discuss this with MNCM before use. During the validation audit, the MNCM auditor will use the patient record not the patient registry. If a clinic uses data from a patient registry, the auditor may find a more recent date/value in the medical record and this would be counted as an error.

**Pre-Submission Data Certification:** This process is intended to help identify potential data issues prior to file submission.

**Pre-Submission Data Certification Form:** Document medical groups complete to outline the method for identifying the eligible population and other details pertinent to the validation of submitted data.

**Preliminary Results:** Results calculated by the MNCM Data Portal after submission of a data file but before results are fully validated.

**Primary Data Contact:** The person from the medical group who uploads/submits data files for the clinical quality measures; receives communications from MNCM about data submission and other important updates; and completes the medical group’s annual registration of the clinics and clinical staff on the MNCM Data Portal. It is important that the Primary Data Contact information for medical groups remains up-to-date to ensure MNCM communication is received by the appropriate person in a timely manner.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login

© MN Community Measurement, 2016. All rights reserved.
2017 Pediatric Preventive Care:
Adolescent Mental Health
and/or Depression Screening

Appendices

Provider File: Excel Template available on the MNCM Data Portal for Clinic and Provider Registration. This document is uploaded to the MNCM Data Portal during registration.

Provider ID: Created by medical group/clinic for providers who do not have an NPI. This ID will be used in the data file submission to MNCM.

Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other countries such as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, Certified Nurse Midwife) are providers that are required to be registered during Clinic and Provider Registration. Refer to the specific measure specifications for eligible provider types required to report clinical data for each measure as they differ.

Provider Registration: See Clinic and Provider Registration.

Provider Specialty Code: Codes generated by MNCM to indicate the board certified specialty of providers. The codes are included in the provider registration file and DDS data file. Please see the Clinic and Provider Registration Instructions guide as well as each data collection guide for further guidance.

Providers Tab: This tab displays all of the information about providers submitted during Clinic and Provider Registration.

REL: Acronym referring to data elements of race, Hispanic ethnicity, preferred language and country of origin.

REL Best Practice: Data collection best practice methods for REL data elements include: allowing patients to self-report race and Hispanic ethnicity, preferred language and country of origin as well as NOT using a multi-racial category; allowing patients to select more than one race; and using a system that allows the collection and reporting of more than one race for each patient. For more information about collecting this data from patients, refer to the Handbook on the Collection of Race Ethnicity and Language Data available on MNCM.org under Submitting Data > Training & Guidance > Data Collection Guides.

REL Data Elements, Field Specifications and Codes: Document to be used in conjunction with the data collection guides to accurately collect and report REL data elements.

Required Exclusions: This type of exclusion is required. A medical group must remove patients from data submission who meet the criteria described in the Required Exclusions section of the Measure Specifications. These exclusions have evidence that they are clinically appropriate or that the frequency and impact of the inclusion of these patients would distort the calculated result.

Results Tab: This tab includes final data results and file downloads from prior submission cycles, as well as charts of current and historical results.

Helpline: 612-746-4522 | E-mail: support@mncm.org | MNCM Data Portal: https://data.mncm.org/login
© MN Community Measurement, 2016. All rights reserved.
Resources Tab: This tab is organized by topic or measure, and houses data submission guides, tools and frequently asked questions by measure.

Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report clinic quality data as one clinic if they meet all of the three following criteria: A) have common ownership; B) have a majority (more than half) of common clinical staff working across the multiple locations (these clinical staff must rotate between all of the clinic locations); and C) the total clinical staff across all locations is no greater than 20 FTEs. Please see clinical staff for further details.

Sample Population: A random selection of patients to be submitted for clinical measures. The sample population is drawn from the total eligible population. The minimum required sample is 60 patients per clinic site. See the EMR Reporting Rule to determine eligibility for sample population submission. Not all measures allow sample population submission. Please see data collection guides for more detailed instructions.

Statewide Quality Reporting and Measurement System: State health reform law passed in 2008. Under this law with specific directives within Minnesota Statutes, section 62U.02, all physician clinics are required to register and submit data on measures to be publicly reported to the Commissioner of Health. To implement physician clinic registration and the collection of quality measurement data, MDH developed SQRMS, created through Minnesota Rules, Chapter 4654. MDH has contracted with MNCM to assist with implementing SQRMS. Under this contract, MNCM supports physician clinics in meeting registration and measure requirements.

Summary of Changes: Area at the beginning of each data collection guide which highlights changes from the previous year.

System Query: Process by which data elements are pulled from chart system (EMR or manual) by clinics/medical groups.

Total Population: Consists of the entire eligible population. Please refer to the specific data collection guides for further instructions on how to submit total population.

Two-Week Review Period: Period after data submission in which clinics/medical groups can review their preliminary results in comparison with other clinics/medical groups. This is a very important validation step to ensure accurate results before public reporting.

Urgent Care Clinics: A type of clinic. Urgent care clinics must register and complete an annual Health Information Technology (HIT) survey; however, urgent care clinics are not required to report on clinical quality measures.

Value Set: A set of administrative codes used to define a concept related to the measure construct (e.g. denominator, exclusions) using standard coding systems (e.g. ICD-10, CPT, LOINC).

Value Set Dictionary: A spreadsheet based list of codes by measure. Contains all Value Sets applicable to a given measure.
2017 Pediatric Preventive Care: Adolescent Mental Health and/or Depression Screening

Appendices

Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission. Warnings should be reviewed to determine if corrections are needed.